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1 INTRODUCTION TO STACC 

1.1 What is STACC? 
STACC, Satellite Tracking Automated Command Console, is an Automated Location System (ALS) 
comprising of four main elements: 

 Mobile components  
 Communication components  
 Base-station software  
 Digital mapping 

A ruggedised GPS and microprocessor on board a mobile unit provides advanced distributed 
intelligence, which analyses data from vehicle based sensors or data. A Base Station PC acquires this 
data, or data from Benefon GPS mobiles, when scheduled, on demand or when predetermined 
conditions exist. The base station software collates, analyses and exploits the data.  The information 
may be transmitted to a base station by radio, cellular or satellite telephone link.   

A dedicated PC is the preferred option for running the Base Station software. STACC requires either 
Microsoft Windows XP or Windows 2000 Professional as an Operating System. Digital mapping is 
selected according to the users specific demands. The Base Station may be at any selected location, 
not necessarily at the unit’s home base. The Base Station collates and analyses data from mobile 
units, acting as the interface for the system supervisor.  

When using the standard STU unit, the system allows up to 15 base stations to monitor and download 
data from the same unit. Each unit will be assigned as a Primary unit to a specific base station. All 
other base stations will be able to view the unit data as a Secondary unit. A base station can send 
messages and receive replies and reports from its own Primary units. It also controls the data logging 
interval and emergency call number. The emergency calls can be directed to any base station. A Base 
station can only send messages and receive replies from its own Primary units. It is not possible to 
use the messaging functions with Secondary units   

Map data at various scales and detail is available for almost every country in the world. MapInfo MapX 
provides mapping support for STACC, allowing a wide variety of map formats to be used. 
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1.2 What can STACC do? 
The STACC Base station initiates mobile data calls to STACC units in the field. Data is downloaded 
and logged from these units by the Base Station. Information can be displayed in various formats and 
reports can be post processed to interpret and analyse the stored data.  

1.2.1 Data Presentation. 
The Map Screen provides a map display showing the latest known downloaded positions, with time 
tags, for all the units being tracked. 

 

Figure 1-1  Map Screen 
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A journey can be re-played for analysis using the View Track function. 

 

Figure 1-2  Map Screen with Track Display 

The Overview map indicates the area of the map that is being viewed in detail in the main area. The 
Track view is used to initiate tracking and data analysis.  
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The latest known time marked position, the status of the last call made and the time of the next 
scheduled call, for all units, is shown in the Tote Screen. 

 

Figure 1-3  Tote Screen 

1.2.2 Calling Units. 
STACC can be pre-set with a number of different calling schedules, allowing units to be automatically 
contacted at predetermined intervals. At any time individual or selected groups of units can be 
manually called. Units can be called directly from the Map or Tote Screens. 

1.2.3 Messaging, Driver Reporting, SMS and Voice calls. 
If a unit is fitted with an In Cab Display messages can be sent from the Base Station to individual or 
selected groups of units. The driver can respond with replies pre-set by the Base Station. In addition 
drivers can send the base station pre-set reports at any time. STACC allows the user to pre-set a total 
of 32 responses to messages or pre-set driver reports. The user can change this at any time. A small 
interface can be fitted to allow mobile voice calls to be received and made to pre-programmed phone 
numbers. Additionally, a keypad can be added to the newest type of In Cab Display, allowing drivers 
to dial any number (usefull for calling ahead on delivery / collection runs). SMS messages can be sent 
and received by the STACC Base Station. 
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1.2.4 Reports. 
Reports can be produced from downloaded unit data. This data may also be exported in various 
formats for use with other data analysis programs, such as Microsoft Excel.  

 

Figure 1-4  Location Report 
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1.2.5 Emergency Calls. 
Alarm systems can be fitted to a unit allowing the driver to trigger emergency messages. When the 
alarm is triggered, an emergency message will be sent to the Base Station. The user is then required 
to acknowledge the emergency. 

 

Figure 1-5  Emergency Event Dialog 
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2 SOFTWARE SETUP 

2.1 Installation of STACC Software 
The STACC installation CD contains all the necessary files and Map Data for your Base Station 
Installation. To install STACC; first, ensure that all programmes running on your PC are shut down. 
Then insert CD in disk drive. 

   Double click on My Computer. 

    Double click on CD Drive. 

   Double click on Stacc-<Version Number>-Setup”   

 

Figure 2-1 Welcome Dialog 

To proceed with the installation. 
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You need to accept the license agreement in order to use the software. 

 

Figure 2-2 License Agreement 

Use Select Destination Directory to choose the 
destination for STACC Application. By default, the 
destination folder for the STACC Application will be 
C:\Program Files\Stacc. The user may wish to change 
the location. 

 

 

 

Figure 2-3 Select Destination Location 

Select Start Menu Folder can be used to set the name 
and/or location of the STACC Application icons within the 
Start Menu. 
 

 

 

 

 

Figure 2-4 Select Start Menu Folder
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With the Select Additional Tasks options, you can 
choose whether or not to create icons on your desktop 
and Quick Launch toolbar (if used). You can also select 
your choice of Company Name in order to use the 
appropriate branding both within the software and on 
reports. 

 

Figure 2-2  Choose your company name 

Ready to Install displays a summary of the 
installation options you have chosen. Pressing 
‘Next’ will start copying files onto your computer. 

 

 

 

 

 

Figure 2-3  Finish Dialog 

 

 

 Figure 2-7 Installing 

When the file copying has finished, you will be presented with another short procedure to install the 
map data. There are no options to choose, so just press ‘Next’ and then ‘Install’. 

  

 
 
 
 
 
 
 
 
 
 
 

Fig 2-7 Map setup  Fig 2-8 Ready to install maps 
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When the map install routine has finished copying files, press ‘Finish’ to return to the main install 
program. 

 

 

 

 

 

 

Fig 2-9 Installing maps         Fig 2-10 Map installation complete 

To finish the installation select 
‘Finish’ on this final page of 
the Stacc Setup Wizard. If 
you do not want to run Stacc 
now, clear the tick-box. 

 

 

 

 

 

Fig 2-11 Installation Complete 
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2.2  Using the STACC Map Layer Control  
STACC can display any maps that you may have in MapInfo “.TAB” format. If you have maps in any 
other format, then please contact Service at any time, who will be pleased to provide you with advice 
on how to convert these to the required format.  

2.2.1 Adding New Maps to STACC 
To add new maps to your STACC map view select Map properties from Map menu.  

 

 

Figure 2-11 Layer Control Dialog 

To add new map Layer. 
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Figure 2-12  Open Dialog 

Browse as with any other Windows-based program to select the map layer you wish to use.  

To add the new map layer to the existing list of map layers.  

Depending on the type of data in this map layer (i.e. whether it is mainly points, lines or areas), 
STACC will put it in the what it believes to be the most appropriate position in the list of existing maps. 
Maps consisting of mainly points (such as city names etc.) will appear near the top of the list, those 
consisting of lines (such as roads) will appear in the middle, and area layers (such as those showing 
counties or countries) will appear towards the bottom of the list. 

To remove the Map Layers Dialog. 

2.2.2 Removing Maps from STACC 
To remove any map layer from STACC. Select Layer Control  as in 2.2.1. Click on the map layer you 
wish to remove. 

To remove selected map layer. 

To remove the Map Layers Dialog. 

Do not remove or alter the position of the “Vehicles” or “ScaleBar” layers as this will affect the way in 
which STACC works. 

2.2.3 Moving Layers 
The position of the layers in the list determines its draw order – this is the order in which layers are 
stacked onto each other (the blue sea is at the bottom as everything else is drawn on top, whereas 
place names are at the top as they are drawn over any roads or area shading). This order can be 
changed. To do this, select Layer Control as in 2.2.1. Click on the map layer you wish to move. 

To move selected layer. 

 

To remove the Map Layers Dialog. 
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2.2.4 Showing a Layers Labels 
MapInfo tables (the map layers) are simply database tables with geographic objects (points, lines or 
areas) assigned to each item. If there is associated text then this can be displayed. 

To display labels. Select Layer Control as in 2.2.1. Click on the map layer of which labels are to be 
displayed. 

To change label style 

 

Figure 2-13 Label Properties Dialog 

Use the Visibility check boxes to govern how the labels appear. For example, adding a tick to the 
Display within Range box will allow the label to appear at certain zoom settings and not at others. 

It is possible to dictate where the label appears in relation to the object by choosing one of the 
Position settings, and also by the Label Offset. This will move the text the  

chosen number of points away from the object in the chosen direction. 

To access Text Style and edit text style. 
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Figure 2-4 Text Style Dialog 

2.2.5 Changing Map Layer Style 
The map layers default style can be changed. 

To change Map layer style. Select Layer Control as in 2.2.1. Click on the map layer you wish to 
change. 

To select Display Properties menu. 

 

Figure 2-5  Display Properties Dialog 

It is possible to ensure that the map layer only becomes visible to the user at particular scales. This is 
an effective way of ensuring that the map remains uncluttered.  

Place  √  in  � for Display with Zoom Range, then chose a Min Zoom and Max Zoom setting. 

Place  √  in  �  for Override Style to change the way the points, lines or areas look. 

14 
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Figure 2-16  Symbol Style Dialog 

This menu can be used to browse and edit new symbol styles for points, lines or areas.  

2.2.6 Making Layers “Editable” or “Selectable” 
STACC does not provide the user with the ability to edit these map layers. To do this the user will 
require a geographic information system (GIS) such as MapInfo Professional. Alternatively, if there is a 
need for some layer alteration (such as the addition of extra items etc.) then contact Service for 
advice. 

Do not place  √  in  �  of Selectable or Editable in the Layer Control display.  

Follow the instructions in the insallation wizard.  By default, the destination folder for the STACC 
Application will be C:\Program Files\Stacc. The user may wish to change the location by pressing the 
“Browse” button on the appropriate screen. 

2.3 Hardware. 
2.3.1 PC System Requirements. 
A dedicated PC is the preferred option for running the Base Station software. Minimum PC 
specification:  

 AMD Athlon 1.8 XP Or Pentium 4 1.7 GHz Processor 
 256mb Ram 
 40 Gb Hard drive 
 16Mb Video card  
 16 bit Sound card 
 Cd rom 
 Floppy drive 
 19" Monitor 

Supported Operating Systems are: Windows XP Professional or Windows 2000 Professional 

Please Note that this specification is suitable for UK Mapping data only, if more than one mapping 
area is added the hard drive size should be increased to a 60 GB hard drive or bigger and an extra 

15 
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128mb ram should be added. A 2ghz processor should be installed and used in conjunction with a 
minimum monitor size of 19" or preferably 21”. 

If more than two mapping areas are added the PC should only be used for STACC, and nothing else. 
Due to the amount of data processing the machine will have to do, running other applications at the 
same time will only slow down or possibly make any part of this operation unstable. 

If the number of units being tracked by a Base station is large, it may require a number of modems. 
The computer will have to be fitted with enough Serial Ports to support these. Alternatively USB allows 
multiple serial connections. 

2.3.2 Base Station Modems. 
STACC systems are supplied with GSM modems. The STACC Base Station can be operated with one 
or more modems. The number of modems required will depend on the total number of vehicles being 
monitored and the quantity and number of calls made to each vehicle. If STACC is configured for 
Emergency calls it is recommended that a dedicated modem be used for incoming Emergency calls. 
STACC allows only one modem to be set for incoming Emergency calls and only one for incoming low 
priority calls. One modem can be set to receive both Emergency and low priority calls. See 4.3.2. for 
modem set up instructions 
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3 DAY TO DAY OPERATION 

3.1 Tool Bar Overview. 
STACC's tool bar is used to provide quick access to common functions. 

View Map Screen. (Shortcut Alt-M) 

View Tote Screen. (Shortcut Alt-T) 

View Message Screen  (Shortcut Alt-I)     

Switch selected unit between Map and Tote Screens.    

Call selected unit. (Shortcut Alt-C) 

Show Report Centre. (Shortcut Alt-R) 

Select unit in main Map 

Pan Map. 

Zoom in. 

Zoom out.  

Centre Map. 

Distance Measurement.  

Back to previous map view. 

Centre main Map on Home. 

Zoom to Local level. 

Zoom to District level. 

Zoom to Regional level. 

Zoom to National Level. 

Show whole map. 

Map pre-sets. 

Show/Hide Overview/Track view. 

Call activity monitor. 

Message Status 
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3.2 Screens/Windows 
There are three main screens used in the day to day operation of STACC, the Tote Screen,  the 
Message Screen, and the Map Screen. There is a fourth screen, the Diagnostic Screen, which is for 
service support. These screens are accessed using: - 

 For the Map Screen. 

 For the Tote Screen. 

 For the Message Screen.  

Or select from The View menu. 

 

On a day to day basis the Overview/Track view is used with the Map Screen and occasionally it may 
be necessary to refer to the Event Viewer and Modem Status. The Queue and History views, 
entered from the View menu, are mainly used for monitoring the system operation, details of these 
can be found in the System Management section of this manual. 

 

To enable the Overview/Track and Event Viewer or select in the View Menu. 

18 
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3.2.1 Tote Screen. 
The Tote Screen lists all the units being tracked by STACC. For management purposes the units can 
be organised in groups. The time and latest known position downloaded for each unit is displayed 
together with the status of the last call made and the time of the next scheduled contact. Calls to units 
can be manually initiated from this screen. (See 3.8.2.2.) The  in the  indicates automatic calling 
enabled for that unit or group.  

 

Figure 3-1  Tote Screen 

To collapse or expand group files click on   -    or   +   

3.2.1.1 View Units in Map Screen from Tote Screen. 

The last known position for a selected unit can be displayed on the Map Screen by Left click to 
highlight selected unit, then      

To go to unit on Map Screen.  

 

Or Right click to highlight selected unit and display menu: 

19 
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Select Goto Unit In Map to display unit on Map Screen.  

3.2.1.2 Last Call Completion. 

These messages appear in Last Call Completion column of the Tote Screen and also the Call 
Notification Queue/History. Unless completion is Call OK the scheduler will recall the unit in 
accordance with the call schedule chosen for the unit. These messages are colour coded for easy 
identification. 

White:   Any non-emergency message containing “OK”  

Green:   Call “In Progress” 

Blue:   “Call Queued” 

Red:   Any “Emergency” message. 

Yellow:   Any other.  

Orange   Data Loss.  

Purple   STU Rejection.  

20 
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"Call Ok" 

“Incoming Emergency Call OK” 

“Incoming Call OK” 

“Incoming Emergency Spot Call OK” 

“Incoming Spot Call OK” 

All data was downloaded successfully.  

"Call Completed With Some Data Loss" 

“Incoming Emergency Call With Data Loss” 

“Incoming Call With Data Loss” 

Most of the data stored on the remote unit has 
been downloaded, but the GSM network loses 
some. This usually involves a small number of 
messages and will be remedied the next time 
the unit is called. Any missing data will then be 
downloaded from the unit. Typically this can 
happen when the unit passes through a GSM 
shadow where reception is patchy, but not 
sufficient to cut-off the call.  

"Invalid Phone Number" Unit phone number has less than 8 digits. 
STACC refuses to call invalid numbers. 

“Call Back Init Not Received” 

“Call Back Originator Not Recognised” 

“Spot Location Not Received” 

Incoming call failed before we could identify. 

Unknown unit called. (identified by data call 
number) 

 

"Base Modem Not Responding" Modem connected to the base station is not 
functioning correctly. STACC will attempt to 
rectify problem by terminating communications 
with the modem and then reconnecting.  

"Remote Modem Not Responding" GSM network provider cannot contact the 
modem on the unit. Reasons include: unit is 
out of GSM network range, unit ignition is off 
and STACC is only on when the ignition is on 
or the SIM card on the unit has been 
deactivated or expired by the GSM network 
provider. 

“Remote Unit Busy Line” Remote unit busy. 

"No Carrier - No Connect" Remote unit answered the call, but then 
terminated the connection immediately. 
Network problem. E.g. congestion. 
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"Bad Connect Response" Modem fitted not approved for use with 
STACC. 

"Synchro Not Received" 

"Download Header Msg Not Received" 

“State Count Not Received” 

Initial contact was made with the unit, but 
contact was lost before any data could be 
downloaded. Reasons may include the unit is 
passing through an area of bad GSM 
reception. Repeated problems may be due to a 
poor location for the base station modem aerial 

"End Download Msg Not Received" Call was cut-off in the middle of downloading 
data from the remote unit. Occurs when the 
unit enters an area with bad GSM reception. 

"End Comm Ack Not Received" Call was cut-off before final confirmation of 
download completion could take place. When 
unit enters an area of bad GSM reception. 

“User Cancelled Queued Call Call cancelled by User. 

“SMS Status Message Received Ok” 

“SMS Position Refresh Received Ok” 

“SMS Received Location Response Ok”  

“SMS Received Tracking Response OK” 

“SMS Received Geofence Warning” 

Benefon Phone responses. 

Status messages received. 

Position initiated by phone user. 

Individual position requested by Base station. 

Position from tracking request. 

Geofence warning received. 

“SMS Sending Location Request SMS” 

“SMS Ok - Location Request Sent” 

“SMS Fail – Location Request” 

Benefon Phone commands requesting 
individual locations.. 

 

“SMS Received Ok” 

“SMS Send Ok” 

Normal SMS received. 

Normal SMS sent.   
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The following completion states occur when an error has occurred either in the remote unit or the base 
station software: 

“Spot Location Msg Invalid” 

"Remote Data Corrupt" 

"Download Header Invalid" 

"Download Msg Invalid" 

Firmware error has occurred in the remote unit. 
Contact Service for advice. 

"Completion State Invalid" Base station software error has occurred. 
Contact Service for advice. 

The following messages indicate that the STU may be not logging data or that data may be lost due to 
data being over written in the STU log.  

“(any of above messages) Missing Fixes” No fixes in download. 

“(any of above messages) May lose data” Data may be overwritten in STU log. 

The “Missing Fixes” error occurs when there are no fixes in the download message. This may be 
caused by calling the unit a second time before it logs a new position.  For example, if the unit has a 
logging interval of 5 minutes and it is recalled after only 2 minutes. This error can also be displayed if a 
fault causes the STU to stop logging. 

The “May lose data” warning indicates that the STU has not been down loaded for a period and in the 
future data in the log may be overwritten. The time that the warning is flagged is set by the “Hours until 
overwrite setting in the Call schedule settings. See 4.3.1.  

STU Rejection – Too many bases  

STU Rejection – Invalid access code  

STU Rejection – No primary access  

STU Rejection – Invalid base station Id  

STU Rejection – Invalid access mode   

STU Rejection – Invalid access format  

The above messages will be displayed when incorrect multi-base station installations are made.  
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3.2.2 Map Screen. 
The Map Screen is used to show the time and latest known position for each unit being tracked and to 
display complete unit routes, which may be examined in detail. Units can be selected and called 
directly from this screen.  

 

Figure 3-2  Map Screen 

3.2.2.1 Mapping Tools. 

STACC has a number of tools to enable the selection of the optimum map view. These tools can be 
accessed from the Map menu on the main menu. 

 

3.2.2.2 View Unit in Tote Screen from Map Screen. 

To see a unit on the Tote Screen from the Map Screen, select with the pointer tool 
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The unit will be surrounded by a red ring, then right mouse click, and select the menu item “View Unit 
In Tote” 

3.2.3 Overview Map. 

 

Figure 3-3  Overview Map 

The Overview Map menu can be enabled from the Map menu or Right click on the Overview Map to 
access contextual menu. 
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3.2.3.1 Overview Map Pan Function. 

 

With Auto Pan enabled the Overview Map will automatically pan if the Main Map area selected is 
outside the currently displayed extent of the Overview Map. 

3.2.3.2 Overview Map Zoom Levels. 

 

There are two pre-set Zoom Levels.    

Use Apply Zoom to change between fixed Zoom Levels.  

3.2.3.3 Select on Overview Map new area for Main Map. 

 Click and drag with the Select Area tool to define new main map area. This Overview tool is initially 
selected on STACC start-up. 

 

The Pan, Zoom In and Zoom Out tools are used to move around and change the scale of the 
Overview Map. The operation of these tools is identical to those on the Main Map Screen. 
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3.2.3.4 Overview set Zoom Levels. 

 

To set the Zoom Levels, use normal Zoom in/out tools to set Overview Map to preferred area. Click 
on Level 1 of Set Zoom sub menu to store. Repeat for Level 2.  

For example, Level 1 can be set to show an entire country, whilst Level 2 can show a regional area. 

3.2.3.5 Overview Start-up Map. 

To set the start-up Overview Map extent, adjust overview map to required view and click on Set in 
Start-up Overview sub-menu. 

 

To return to this default, at any time, click on Revert in Start-up Overview.   

3.2.3.6 View Entire Overview Map. 

To view entire Overview Map click on View Entire Overview in sub-menu. This function is used when 
first setting up the Overview Map. 
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3.2.3.7 Change Overview Map Layers. 

 

To change the geoset (collection of mapping layers) used by the Overview Map.  

3.3 Zooming in and out of the Main Map.  
 

Allow conventional click and drag Zooming.  

 

Select pre-set, Local, District, Regional and National views.  

3.3.1 Click and Drag Zoom of Main Map. 
Zoom in/out tools can be selected from the Tool Bar, Tool sub-menu of Map menu.   

Or right click on map and use Tool sub menu: - 

Having selected the Zoom in or Zoom out tool click and drag to scale area. Pressing and holding Ctrl 
can change the zoom tool action.  

3.3.2 Zoom Levels Main Map. 
Zoom level is selected from the Tool Bar or Tool sub-menu of the Map menu. 

 

Select Zoom Level. 
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3.3.3 Map Pre-sets 
Predefined map displays can be stored for future use.  

To save current map or select/edit exiting map pre-sets. 

 

 

Select Save Current Map to store existing map display. 

Select Manage Map Pre-sets to edit existing Pre-sets.  

 

To edit Pre-set names and delete Pre-sets  

use Map Pre-set window.  

When saving Pre-set enter name. 
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3.3.4 Main Map Scale Rule. 

 

 The main map Scale Rule is turned on/off from the View menu. 

 

Scale can be displayed in Kilometres or Miles. 

See 3.4.8. Map Measuring Systems 

3.4 Moving around Map. 
 The Main map can be moved using the Pan tool, or by selecting an area on the Overview map. 

Alternatively, Zoom in/out tools may be used to reposition the map. 
 A Home position can be set on the map; (See 4.1.1.) this would normally be the centre of 

operations.  
 The map can be centred on the Home position.   
 The previous map can be displayed.  
 The map can be centred on a selected unit from the Tracking window or from the Tote screen as 

described in section 3.2.1.1. 

3.4.1 Main Map Pan Function. 
 

Selects Pan from the Tool Bar.  

Pan can also be selected from the Tool sub-menu of the Map menu or Right click on the Map view 
and use the Tool sub-menu. 
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3.4.2 Change Main Map View using Overview Map. 
To select a new map area from the Overview Map, click and drag to define area required. 

 

Click and Drag on Overview Map. 

 

3.4.3 Centre Main Map on Home. 
 

To centre map display on Home. 

 

  Or select Go to Home on the Map Menu.    

3.4.4 Back to Previous Map view. 
 

To return to the previous map displayed.  
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3.4.5 Centre Map on Unit not in current view. 

 

With the Overview/Track view displayed, the Track view can be used to find units on the Main map.  

Select the Target unit in the Track Target view.  

 

To centre map on choosen unit.  

3.4.6 Centre Map on Unit visible in current view.  
To centre on a unit on the Map Screen. To select unit. 

Right click on Map to enable sub menu: -.  
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Select Centre Map on Unit to move map. 

3.4.7 Centre Map on selected point. 
 

To centre Map Screen on selected point  

Position symbol at selected centre point and left click. 
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3.5 Measuring Distance and Cursor Position. 
 

To measure distances on Map Screen.   

 

Figure 3-4  Map Screen with Distance 

Position marker at start point, right click, move to next point and right click repeat until total route 
length measured. The Cursor position is displayed and continuously updated. 

For clarity route marked clear of roads in example above. 

3.6 Display Unit Details 
The details of any unit shown on the Map Screen can be displayed. 

To select unit 
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Selected Unit tab on Track view to view details. 

3.7 Tracking. 
The track for a selected unit can be displayed and analysed on the Map Screen.  

 

To display track, if Overview/Track view is not displayed, select Overview/Track in Map menu  

3.7.1 Select Unit to be Tracked. 

 

35 
 



STACC V5.3 User’s Manual  January 2006 

Select the unit to be tracked in the Unit drop-down menu on Track Target page. Or: 

 

To select a unit on the Map Screen.  

 

3.7.2 Set Tracking Period. 
Select the period over which you wish to view the track using the Analysis Period and Start/End 
Date in the Track Target overview. The track period may be defined in one of two ways. Select a 
track date, then, either:  

 

Pick an analysis period and choose whether this runs before or after the track date.  

Or,  Pick 'To End Date' as the analysis period, and select an end date. 

3.7.3 To View or Clear Unit Track. 
To display track of selected unit.  

To clear track.   
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Figure 3-5  Overview Map with Track 

The displayed track is made up from a series of locations extracted from the database. The interval 
between these locations will be the larger of either the interval at which the unit is logging position data 
or the interval set to extract data from the database. See 4.4.1. 

3.7.4 Track Playback. 
Use the track controls on the Displayed Unit overview to run throuh the unit’s track. 

 

Displayed Track shows Unit Id, Start date/time and End, date/time of displayed track. 
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At any point on the track will display unit time and date. 

 

3.8 Outgoing Calls to Units. 
The STACC Base Station will call units, to download stored data, automatically or on demand. The 
automatic calls are controlled by the Call Scheduler. Even when the base station is unattended data 
can be downloaded and stored. At any time a request can be made to immediately contact selected 
units. The number of outgoing lines available limits the number of calls that can be made 
simultaneously by STACC. The scheduler determines the time and priority of outgoing calls. If a call 
fails to make contact the call will be re scheduled at a higher priority. The time between retries and the 
number of retries is set in the Call Schedules. See 4.3.1. If Benefon units are used with STACC they 
can be programmed to automatically send their position to the STACC base station with out being 
called by the scheduler. 

Automatically scheduled and manual calls are allocated a priority. The higher the number the greater 
the priority: -  

Type of call Priority 

Automatically scheduled first call 1 

Automatically scheduled first retry 2 

Subsequent retries +1 

  

Manual first call 100 

Manual first retry 101 

Subsequent retries +1 
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Emergency first call 400 

Emergency first retry 401 

Subsequent retries +1 

When any outgoing or incoming call is in progress, this is indicated by the animated mobile 
phone symbol in the Tool Bar.  

3.8.1 Scheduled Outgoing Call   
Calls can be scheduled for selected days of the week at fixed intervals and at specific times. On a day 
to day basis it would not normally be necessary to change these schedules or change the particular 
schedule used by an individual unit. Creating new schedules and modifying existing schedules is dealt 
with in detail in section 4.3.1. Unless a change in the schedule is required, no action is required by the 
operator for the scheduled calls to be made. 

 

A tick in the schedule box, under Unit Id in the Tote Screen indicates that the scheduling is active for 
that unit.  

Click on box to enable/disable scheduling.  

Warnings if running automatic call scheduling. 

It is recommended that the STACC Base Station PC is left running 24 hours a day to ensure all 
scheduled calls can be made.If STACC is being run on a PC which is used by other software, leave 
STACC running in the background whilst other programs are being used. 

MAN ERF Telematic Services recommend that separate mobile modems dedicated to STACC be 
used. If however the modem is used for other programs it will be necessary to disable the STACC 
modem connection before use. Failure to re-enable the modem for STACC's use may lose valuable 
data. 
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3.8.2 Outgoing Calls on Demand. 
At any time you can request that STACC calls and downloads data from a unit or a group of units. 
STACC will call the unit as soon as possible. Select the Call Request Queue from the View menu to 
view calls waiting to be made. Top unit in queue will be called next. 

 

 

Call requests to individual units can be instigated from the Map Screen and the Tote Screen. Calls to 
entire groups can be made from the Tote Screen   

3.8.2.1 Requesting Individual Outgoing Calls from Map Screen. 

To call a unit, which is on the Map Screen: -  

To select unit.  

To initiate the call 

Or: 
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,   

Right click on map and select Call Unit Now. Or: 

 

Select Call Unit Now from the Unit menu 

If the Overview/Track overlay is enabled on the Map Screen to request a call: - 

 

 Select the unit in the Track Target  

 

To select unit. 

 

 

To request call 

 

 

3.8.2.2 Requesting Individual Outgoing Calls from Tote Screen. 

To call a unit, which is on the Tote Screen, left click on unit.  
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Right click on unit and initiate call from sub-menu. 

Or                to initiate call. 

 

 

Or initiate the call from the Unit menu  

3.8.2.3 Requesting Individual Outgoing Calls from Group menu. 

It is possible to call a unit from the Unit collection overlay.  

 

Select Units from Group Menu.   
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Figure 3-6  Units Collection Dialog 

To call a unit, from the Unit collection, click on unit.  

To call unit.  

Normally calls would only be made from this overlay when checking new units added to the system. 

3.8.2.4 Requesting Outgoing call to all units in a Group. 

From the Tote Screen it is possible to request outgoing calls to a Group of units. 

  

Right click on Group header to enable contextual menu. 

 

Click on Call All Units In Group to request call to all units in Group. 
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Un-tick box to remove unit from list to be called. 

To start calls   
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3.9 Incoming Emergency/Low Priority Calls. 
The STACC Base Station normally initiates the data download from units. The system is designed to 
accept incoming calls when required. If the system is used for Emergency calls we recommend that a 
dedicated incoming line be used. See 4.3.2. where setting up STACC for incoming calls is discussed 
in detail.  

On receipt of an emergency message the Emergency Event warning is displayed. 

 

To confirm emergency noted.  

The emergency dialog cannot be closed prior to acknowledgement.  

To show location of emergency. 
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Do not clear Emergency Event window at this stage.  

If emergency dialog cleared before emergency location shown, this emergency message can be 
redisplayed from the Event Viewer. See Section 4.5.1. 

 

The position of the unit transmitting the Emergency call will be shown, marked by a red cross, in the 
centre of the Map Screen. 

AT THIS POINT FOLLOW EMERGENCY PROCEDURE SET BY COMPANY 
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3.10 Messaging, Driver Reporting. 
If the unit is fitted with an In Cab Display messages can be sent from the Base Station to individual or 
selected groups of units. The driver can respond with replies pre-set by the Base Station. In addition 
drivers can send the base station pre-set reports at any time. STACC allows the user to pre-set a total 
of 32 responses to messages or pre-set driver reports. The user can change this at any time. Before 
the messaging/reporting system can be used it is necessary to ensure that two procedures have been 
carried out. 

First a Base Station modem must be configured for incoming calls. See 4.3.2.1. 

Secondly a set of Message Replies/Driver reports must be uploaded to the unit. This is achieved by 
entering the required replies and reports as in 3.10.1. and then making a normal call to the unit. This 
call could be the next scheduled call to that unit or if necessary it can be called immediately. If the list 
of replies/reports is changed in the future, it will be necessary to call the unit to update its responses. 

Normally STACC carries out its communications using GSM data calls, as this is the most economical 
method of transferring information. The messaging system allows calls to be made using either data or 
SMS. Please note the use of SMS could considerably increase the communications costs of 
STACC. The system allows the Base station to predetermine the method used for calling and replying 
to Drivers Messaging. When driver sends a report he can select a data or SMS reply. Our 
recommended choice of communication would be: - 

Message Type Out In Reason 

Non Urgent to one or 
a few units. 

Data- Scheduled call  Data Cheapest call charges 

Urgent to one or a 
few units 

Data- Demanded call SMS Outgoing data calls are cheaper 
than SMS 

Non Urgent to many 
units 

SMS Data If outgoing data call is used this may 
delay normal scheduled calls. 

Urgent to many units SMS SMS If outgoing data call is used this may 
delay normal call schedule. Replies 
sent without recalling unit. 

Non Urgent Driver 
report 

N/A Data Cheapest 

Urgent Driver report N/A SMS Message immediately sent to Base 

 

3.10.1 Pre-setting/Editing/Deleting Message Replies/Driver Reports. 
The Base station can set up to a total of 32 replies to messages or Driver reports. The pre-set 
messages/replies apply to all units being monitored by the STACC Base Station. The pre-set 
replies/reports apply to all units in all groups controlled by the base station different replies/reports 
cannot be used for separate groups or units. For the new settings to be uploaded to the remote unit, 
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normal data calls must be made to each unit in the group. To set pre-set messages/replies select 
Driver Presets from Messaging menu: - 

 

 

Highlight message to be edited 

To edit selected message/report. 

To make pre-set a reply to a Base Station Message √ Enable only.  

To make pre-set a Driver report √ both Enable and Permit Unsolicited Responses. 

 

Edit Pre-set Message 

To clear reply/report highlight.  

3.10.2 Entering/Editing/Deleting Pre-set Messages. 
Messages can be entered individually as required or where messages are repeated stored as Pre-set 
Messages. To enter a new or edit an existing Pre-set message, from the Message menu select 
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Preset Messages To Send. A message can also be added or edited from the Send In-Cab Message 
window. See 3.10.3. 

 

 

To enter new message 

 

To enter new message. Enter New Pre-set Message 

 

To edit existing message, highlight message.  

 

 To save modified message. 

To delete message, highlight message to be deleted. Click Confirm deletion 
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3.10.3 Sending Messages. 
To send message from Message menu select Send Message. To send message from Tote Screen 
select unit and right click to show contextual menu, select Send In-Cab Message.   

 Send Message from Message Menu 

  Send Message from Tote Context Menu 

 

Figure 3-7  Send In-Cab Message Dialog 
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Select units to which message will be sent by  √ in  � in 1. Check units to send message to. 

To send message to all units. 

To clear all requests to send messages. 

To expand groups. 

Choose pre-set message from 2. Choose Preset Message. Or enter new message in 3. Customise 
Message.   

To edit existing pre-set messages. 

   To store new message as pre-set. 

For sending urgent messages  √  in   �  in 4. Message delivery. 

For receiving urgent replies  √  in   �  in 5. Message responses. 

To set Driver Responses. 

 

Select driver’s responses to message by  √  in  �. 

To send message. 

NOTE:  If Urgent messaging (SMS) is selected the message will be add to the calling queue and sent 
as soon any current communication is complete. Non urgent essages will be sent as part of the next 
data call made to that unit. If a call to that unit is not scheduled for some time the operator can call the 
unit as in 3.8.2. 

3.10.4 Monitoring Messages, Receiving Replies/Reports. 
To view messages, replies and reports select Message Screen  
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Figure 3-8  Message Screen 

The Message Screen displays all current messages sent and reports received. Replies to messages 
are displayed appended to the outgoing message. 

New incoming reports and replies are brought to the attention of the operator by the flashing Message 
Icon in the STACC tool bar. 

To acknowledge the new reply or report, Right Click to highlight selected line and display menu. 

 

Select Mark As Read to stop new message warning  

For more information, time and date, Right Click to highlight selected message, report or reply to 
display menu. 

Select More Info…  to display additional information. 
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Figure 3-9  Incoming Message Dialog 

3.10.5 To delete messages. 
 

Individual or all messages, replies and reports can be deleted from the Message Screen.  

To delete individual items, Right Click to highlight selected message, report or reply to display menu. 

  

Select Delete to remove highlighted item. 

If a message selected for deletion has not received all replies a warning will be displayed. If the 
message is then deleted, later replies will still be displayed but not related to the original message.  

 

To delete all messages from the Message Screen from the Messaging Menu: - 
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Select Delete All Messages to clear all messages, replies and reports from the Message Screen. 
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3.11 Voice Calls and Phonebook 
PLEASE READ BEFORE ATTEMPTING TO USE STACC PHONEBOOK 

3.11.1 Introduction 
STACC versions from 2.2. use multiple phonebook sets that can be uploaded to individual or groups 
of units. Earlier versions were limited to only one phonebook. All phone numbers used must be 
entered into the Master Phonebook. A Phonebook Set consists of numbers which are selected from 
the Master Phonebook. A Phonebook Set can only be uploaded to units that are under Primary 
control of the Base Station.   

3.11.2 To load Master Phonebook. 
Select Phonebook from Tools menu   

 

 

Figure 3-10  Master Phonebook Dialog 
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The Short Name and the Number will appear on the In Cab Display when this number is selected. 
The Full Name is for the use of the Base Station user and does not have to be used if not required. 

Complete required entries and Submit 

There is a limit to the number of Phonebook entries that can be stored in a Phonebook Set. The 
Phonebook Set is sized dynamically. If short Short Names and short Numbers are used more 
entries can be uploaded. Save space by not entering Country codes if the unit is not used abroad. 
Spaces in phone numbers can also be omitted to save space.  

There are some Advanced Features for Phonebook Entries, to change these settings, press the button 
with showing >>. This will expand the dialog to: 

 

The first attribute must be set if this phone number is to receive voice calls from STU. The Spot 
Location and Tracking request options are for Benefon phones only. 

3.11.3 To Edit or Delete Phonebook Entries. 
Open Phonebook as in 3.11.2. Highlight entry that you wish to Edit or Delete.  

Edit in entry boxes or delete 

3.11.4 To prepare a Phonebook Set. 
Having entered the required phone numbers in the Master Phonebook the Individual Phonebook 
Sets can be constructed. 
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From Tools menu select Phonebook Sets.  

 

To Enter New Phonebook Set 

Enter new Set name, then: 

 

To edit existing Phonebook Set Left click on Set name. 

To copy existing Set Left click to highlight required Set. Enter new Set Name 

To rename existing Set Left click to highlight required Set. Enter new Set name. 
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Left click to highlight required number in Phone Numbers Available window and move to Phone 
Numbers In Set window by double clicking or  

 

To remove numbers from Phone Numbers In Set window, Left click to highlight number and double 
click or  

 

After completing required Phonebook Set 

If changes not required will remove all recent changes.    

If too many numbers are entered in the Phonebook Set a warning will be displayed when saving. See 
3.11.2.    

Remove Phone Number entries, until you can save without warning being shown. 
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3.11.5 To Enable Phonebook Upload. 
Units must be individually enabled for Phonebook Set uploading. The Phonebook Set will only be 
uploaded when new or when changes have been made to the existing Set. 

 

Select Units from Group menu. 

Select Unit to be edited or new Unit entry. Select Phonebook Settings. 

 

Put √ in the  � to enable Phonebook Upload  

Remove √ from � to disable Phonebook Upload  

Select required Phonebook Set from Select Phonebook drop down menu. 

If the unit is not scheduled to be called for some time you may wish to call it immediately to update the 
unit’s phonebook. 
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3.12 User Defined Places - Labels and Geofences. 
3.12.1 Introduction. 
This function allows the user to give their own Labels, Addresses and Geofence areas to selected 
locations. The Labels are used on the Map View and the second, longer version is used in place of 
the postal address in the Tote Screen and for Reports. Geofences are used to record entry or 
departure from the defined area. The event is logged and if requested an SMS message can be 
automatically sent to the base station. When an SMS is received the Tote Screen will be automatically 
updated and a Warning can, if required, be displayed. 

Note:  Deleting or changing Geofence details in the User Place Label list that have already been 
uploaded to the remote unit may cause errors when producing Geofence reports.     

3.12.2 Enter New Place. 

 

Select location of new label on Map View by right clicking with Select Show Location from sub menu 

 

To Edit Place Name Label 

 

Figure 3-11  Current Position Dialog 
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Figure 3-12  User Place Dialog 

Enter Place Label for Map View.  

Enter Address for Tote Screen and Reports. 

Select and set Radius of Place Label.  

Select and set Geofence Radius. 

Set Geofence Alert status. 

Select required symbol and colour. (Do not use black on white backgrounds) 

If Advanced options are required, press the Advanced Geofence Features button, which will extend 
the dialog: 
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Figure 13  Expanded User Place Label Dialog 

The advanced features are mainly related to the Sending of SMS (Text Messages) to mobile phones 
when the a Unit enters or leaves a Geofence. SMS messages will only be sent to phones that are in 
the phonebook held in each STU, and labelled as being able to accept such entries. See also the 
section on Advanced Phonebook Entry features. 

Accept if entry when correct by pressing the OK button. 

3.12.3 Edit/Delete Places   

 

Select User Place Labels from Tools menu. 
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Figure 3-14  User Place Labels Dialog 

Highlight Place Name Entry and use Edit/Delete, or left and right  on label on Map View. 
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Figure 3-15  Edit User Place Dialog 

3.12.4 Show/Hide Place Address and Geofence Areas  
Select User Place Labels from Tools menu. 
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Figure 3-16  User Place Labels Dialog 

Highlight label to show or hide individual Address or Geofence areas. 

Or select Show All or Hide All to show/hide all Address or Geofence areas. 

Or left and right on label on Map View to Highlight Label 

.   

 

Select Show or Hide Address or Geofence area selected label. 
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To Show/Hide all Address and Geofence areas. Right mouse click on Map View.  

 

Select Show or Hide Address or Geofence areas. 

3.12.5 Selecting areas not covered by single radius. 

 

If you wish to Address or Geofence an area which cannot be covered by a single label enter a group 
of areas with identical descriptions. 

3.12.6 Geofence Sets. 
STACC versions from 5.0. use multiple Geofence Sets that can be uploaded to individual or groups of 
units. Earlier versions were limited to only one set of geofences. All geofences used must first be 
entered into the User Place Label list. Geofence Sets consist of geofences which are selected from 
the User Place Label list. Geofence Sets can only be uploaded to units that are under Primary 
control of the Base Station.   

Geofence SMS messages can only be sent to the controlling Base Station. Logged geofence 
activations will be recorded by other base stations. In order to use this information both stations must 
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use the same User Place Label list. The list is contained in the file UserPlaces.dat this is normally 
found in C:\Program Files\STACC. This file should be copied from the master to other stations. 
Contact STACC Technical support if you require assistance with this.   

 

From Tool menu select Geofence Sets.  

 

Figure 3-17  Geofence Set Selection Dialog 

To Enter New Geofence Set. Enter new Set name, then   

 

To edit existing Geofence Set Left click on Set name. 
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To copy existing Set Left click to highlight required Set. 

Enter new Set Name 

To rename existing Set Left click to highlight required Set. Enter new Set name. 

 

Left click to highlight required number in Geofence Available window and move to Geofences In Set 
window by double clicking or  

 

To remove numbers from Geofences In Set window, Left click to highlight number and double click or  

 

After completing required Geofence Set    

If changes not required, Undo will remove all recent changes.    

If too many Geofences are entered in the Geofence Set a warning will be displayed when saving Set. 
Remove Geofence entries, until you can save without warning being shown. By reducing the Map 
Label Text used, it may be possible to increase the number of Geofences in a Set 

3.12.7 Enable Geofence Upload 
Select Units from Unit menu. 

 

Select Unit to be edited or new unit entry. Select Geofence Settings. 
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Figure 3-18  Edit Unit Geofence Dialog 

Put √ in the � to enable Geofence Upload  

Remove √ from � to disable  Geofence Upload  

Select required Geofence Set from Select Geofence drop down menu. If the unit is not scheduled to 
be called for some time you may wish to call it immediately to update its geofence data. 

3.12.8 Geofence Alarms and Reports. 
All geofence activations are logged and downloaded to the STACC Base stations when the remote 
unit is called by the Base station. (Both scheduled and unscheduled calls). If the SMS option is 
selected a Geofence Alarm will be activated on receipt of the SMS.  

Geofence Reports by Unit or by Geofence can be generated. See 4. Reports and Data Extraction. 
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3.13 Location Address and Gazetteer. 
The address of any position selected on the Map display can be displayed or where Postal or Zip 
codes are used a gazetteer allows the position and address to be indicated. These positions can be 
labelled for future reference. 

3.13.1 Location on Map 
Right Click on map at required location. Select Show Location from sub menu.  

 

  
  
  
  
 

 Figure 3-19  Current Location Dialog 

Select and name label if required. 

3.13.2 Gazetteer. 
Enter Co-ordinates, Post or Zip code to display position and address on Map View 

The Gazetteer function is selected from the Tools sub menu 

 

 

70 
 



STACC V5.3 User’s Manual  January 2006 

 

Figure 3-20  Gazetteer Dialog 

STACC Displays position and address. Centre of Post code top left corner of Label 
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3.14 Benefon Tracking. 
3.14.1 Setting tracking. 
The Benefon Trac Pro phones can remotely set from STACC to automatically send the last recorded 
position at a defined interval and for a specified number of times.   

To set required tracking parameters:  

From Tote View select phone to be configured by right clicking to display menu. Select Send 
Tracking. 

 

 

 

Figure 3-21  Benefon Tracking Dialog 

Set Tracking interval. Set number of tracking messages required. 

 To update phone.  

3.15 To Deactivate Tracking. 
To deactivate tracking parameters. From Tote View select phone to be configured by right clicking to 
display menu:- 
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Select Send Tracking. 

 

Figure 3-22  Benefon Tracking Dialog 

Tick Deactivate Tracking box.  

To call and deactivate phone tracking.  

73 
 



STACC V5.3 User’s Manual  January 2006 

3.16 SMS Text Messaging and Benefon Status Messages. 
STACC supports the sending and receiving of SMS messages from any phone that is registered with 
STACC. Benefon Status messages are also received and displayed by STACC.  

3.16.1 To Send SMS Text Message. 
From Main Menu select Message Menu select Send SMS. 

 

 

Figure 3-23  Send Free Text SMS Dialog 

Tick box of units to which SMS is to be sent (one or more). Select Preset Message or enter 
Customised Message 

To send SMS. 

3.16.2 Enter/Edit Preset Messages. 
From Main Menu select Message Menu, select Preset Messages To Send  
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Figure 3-24  Preset Send Messages Dialog 

To edit new message.     

 

Figure 3-25  Edit Preset Message Dialog 

Existing messages can be selected and edited.  

Customised messages can also be added to the Preset Messages from Send Free Text SMS by 
clicking on. 

 

3.16.3 Receiving SMS Text and Benefon Status Messages. 
Received SMS Text Messages and Benefon Status Messages are displayed on the Message View.  

Benefon Status Messages include position information which will be used to update the Tote View 
and the Map View location of unit. 
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3.17 Benefon Geofencing. 
The Benefon Trac phone supports simple geofencing.  A single area is defined by a point and radius. 
The phone can be set to trigger the geofence message either by being inside or outside the defined 
area (not both). 

A time interval is set at which the phone will look to see if it is in (or out of) the defined area. If the 
geofence is broken at this point an SMS message will be sent to the Base Station.  

Note: If the condition exists at the next time interval the alarm will be repeated unless the geofence is 
deactivated by the Base Station. 

3.17.1 To Define Geofence Area. 
See 2.12.  User Defined Places - Labels and Geofences to enter Geofence details. 

3.17.2 To Upload Geofence. 
From Tote View right click on Benefon unit to display menu, select Send Geofence. 

 

Select required geofence by tick in box.  

Select Notify inside or outside 

Set interval at which phone examines geofence status. 

Press Send. 
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Figure 3-26  Select Benefon Geofence Dialog 

3.17.3 To Deactivate Geofence. 
Select unit as in 3.17.2 and enter Select Geofence as above. 

Select Deactivate.  

Press Send. 

3.17.4 Received Geofence Messages. 
Received Geofence messages are used to update the Map Screen and the Tote Screen unit 
positions. 

Various Geofence reports are also available. 
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3.18 Keyboard Short Cuts. 
Primary screens are Map Screen, Tote Screen, Message Screen and Diagnostic Screen. 

Short Cut Function Valid from Primary Screen 

Alt+A Display/Clear all Status Windows. All 

Alt+B Display Master Phonebook All 

Alt+C Request Call to selected Unit. Tote and Map 

Alt+D Display Diagnostic Screen Tote, Map, Message 

Alt+F Benefon Trackbox Configuration All 

Alt+G Display Gazetteer. Tote and Map 

Alt+I Display Message Screen Tote, Map and Diagnostic 

Alt+L User Places List All 

Alt+M Go to Map Screen. Tote, Message and Diagnostic 

Alt+P Display Preference List. All 

Alt+R Display Report Centre All 

Alt+S Display Call Schedule List. All 

Alt+T View Tote Screen Map, Message and Diagnostic 

Alt+U Display Unit Details List. All 

Ctrl+C Copy Map. Map 

Ctrl+L Go to Selected Unit in Tote/Map Tote and Map 

Ctrl+P Print Main Map display Map 

Ctrl+S Save Configuration File. All 

Ctrl+ (Keypad +)   Expand columns to fit data Tote and Tables 

 

 Hold Ctrl to reverse function of Zoom tools. 
 Space Bar will √ or clear any highlighted  .In Tote Screen 
 Numeric keypad and  will expand and collapse selected Group structures. 
 ∗ will expand all contained Sub-groups. 
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4 SYSTEM MANAGEMENT. 
The management of the STACC system includes setting of Preferences, setting up Calling 
Schedules and Modem parameters and entering Unit and Group details. These entries may be later 
modified as necessary. When the system is running various reports and status windows are used to 
monitor the operation of the system.  

4.1 Mapping. 
The Main map and Overview map data will normally be set when the mapping software is initially 
installed. You may wish to move the Home location or change the Overview Zoom Levels or Startup 
Setting.  

4.1.1 Home Location. 
The Home marker, which can be used to centre the map, can be positioned, to mark the Base Station, 
normal unit depot or centre of operation. To position the marker, move the map so that the point that is 
to be Home is at the centre of the map display.  

 

Click on Set Home Location on the Map menu to place Home marker on centre of map. 

If Home position is not exact, repeat process. (Hint: Zoom in before repeating) 

 

To go to Home Location    
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4.2 Unit Management. 
After a unit is equipped with a STU details must be entered into the STACC Base Station to enable 
communication between the base station and the unit. The unit may be monitored from more than one 
Base Station. One Base Station designates the unit as a Primary. Other Base Stations can monitor 
the unit as a Secondary provided they have the access code. The Base Station that has Primary 
control has full monitoring, messaging facilities and controls the Access Code. Stations with 
Secondary control can not receive messages from the unit, though messages can be sent to the 
units. (If In Cab Display fitted) They cannot make any changes to data stored in the STU such as 
Phone numbers, Logging intervals and Geocoding details.     

4.2.1 Adding/Editing Unit details. 
Unit details are added or edited in the Unit Collection.  

Select the Group menu and click on Units to enable Unit Collection.   

 

To edit existing units the Edit Unit window can be enabled directly from the Tote Screen and Map 
Screen. 

 

Right click on unit to enable sub-menu in Tote Screen.  

In Map Screen Left click on unit. 

Then Right click to enable sub-menu  
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Figure 4-1  Units Collection Dialog 

To enter new unit 

Or double click on clear area of Unit Collection to enter a new unit details 

To edit, double click on Unit  

Or Left click on existing Unit. 

To edit unit details 

To delete, Left click on existing Unit  

To delete. 

Right click on unit to enable contextual menu to Edit or Delete.  
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Figure 4-2  Edit Unit General Dialog 

For new units, enter the Unit Identifier, this can be any alphanumeric id. Set GSM or Radio 
communications, Unit Symbol and Unit Colour.  

Tick  Installed in Trailer �   if the actual STU (not tag) is fitted in Trailer Unit. 

Select GSM Comms Settings or Radio Comms Settings as appropriate. 
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Figure 4-3  Edit Unit GSM Comms Dialog 

Enter the Data call Number, select or edit a Call Schedule (If a suitable schedule does not exist. See 
4.3.1. to produce a new schedule.), select Primary or Secondary and enter Access Code 

Note: Access Code for Secondary is the code set by the Base Station which has Primary control.  

Select Phonebook Settings. 
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Figure 4-4  Edit Unit Phonebook Dialog 

Put √ in the  � to enable Phonebook Upload  

Remove √ from � to disable Phonebook Upload  

Note:  The current version of STACC only supports a single phonebook to be used by all units. In the 
very near future the option to use more than one phonebook will be introduced. 

Select Geofence Settings 
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Figure 4-5  Edit Uint Geofence Dialog 

Put √ in the � to enable Geofence Upload  

Remove √ from � to disable  Geofence Upload  

Select Temperature Settings. 
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Figure 4-6  Edit Unit Temperature Dialog 

Select Sensor type fitted. 

If Temperature Tag fitted complete Temperature Logging Settings and  Temperature Tag Alarm 
Conditions. 

If Transcan Unit fitted complete Temperature Logging Settings. Alarm conditions set locally on 
actual Transcan unit. 

4.2.2 Group Structure. 
If required the units can be organised into groups on the Tote Screen. (E.g. Despatch, Service, and 
Sales). This function is particularly useful where calls may be requested to groups of units.  

To change the group structures, select Tote View left click on top line to add new group or on existing 
Group line if new entry to be a Sub-group  

Select Organise Group from Group menu. 
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Alternatively Right click on highlighted line to access sub menu.   

 

Enter new name. Click New Group to enter name of group on Tote Screen 

 

Figure 4-7  Group Name Dialog 

New Group name will appear on Tote Screen. Units can be moved between Groups by clicking and 
dragging the unit to new Group.  

To rename existing Group, click on Group name, select Organise Group sub-menu and click 
Rename Group to enter new name.   

 

Figure 4-8  Group Rename Dialog 

To delete an existing Group name, click on Group name, enable Organise Group sub-menu and click 
Delete Group. Confirm deletion.  
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When a Unit name is deleted all units are placed in the containing Group, Units can be individually 
deleted or click and dragged to new Group. 
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4.3 Communications Management. 
4.3.1 To Enter/Edit Call Schedules. 
STACC supports multiple Call Schedules. A schedule can be applied to individual units a number of 
units or a Group. The schedules set the call interval times and data logging rate at the unit. When 
setting up schedules it is important to plan carefully to ensure that calls are kept to the minimum for 
cost efficient operation. The interval at which data is logged will also effect the maximum time between 
calls to avoid loss of logged data. See Appendix, which gives recommended calling times and costs 
against data logging rates.  

4.3.1.1 To Enter/Edit Call Schedule from Group menu. 

Select the Group menu and click on Schedules to access Call Schedules.   

 

 

Figure 4-9  Call Schedules Dialog 

 or double click on clear area of Call Schedule for new schedule. 

Click on existing schedule. To edit. Or double click on existing  schedule.   

To delete click on existing schedule. To delete. 

Right click on schedule for contextual menu. To Edit or Delete. 

 

4.3.1.2 To Edit Existing Schedule from Tote or Map Screen. 

Right Click on existing schedule and select Edit Schedule or Delete Schedule. 
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To edit existing call schedules the Edit Call Schedule window can be enabled directly from the Tote 
Screen and Map Screen. 

Right click on unit in Tote Screen to enable sub-menu. 

 

Click to select unit on Map Screen then Right click to access contextual menu.  
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Figure 4-10  New Call Schedule Dialog 

There are three groups of controls, Schedule Details, Daily Poll Periods, and Daily Call times. 

4.3.1.3 Enter/Edit Schedule Details 

Each schedule must have a unique Schedule Name.  

Log Location Every determines how often data is logged on the unit's STACC unit. 

If Flag possible data overwrite enabled a warning will be shown on the Tote Screen indicating that 
data may be overwritten in the remote unit. This is usually caused by being unable to contact the unit 
for a long period of time due to GSM failure etc.  

To overcome the limitations inherent in mobile data communications, the user sets the number of 
times a unit is to be re-called in the event of call loss, Max Call Retries. The time interval between 
each retry is also specified, Retry Wait. 

4.3.1.4 Enter/Delete Schedule Poll Period. 

Daily Poll Periods are used to define how calls are periodically made throughout the week. Different 
call rates may be defined for different times of the day. The user may define the daily polling schedule 
over a 24-hour period, starting from 00:00. This is then applied to selected days of the week. 

By default a new Call Schedule is set to make no periodic calls. Poll Periods may be created, edited 
and deleted using the appropriate buttons. 
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Before creating your first Poll Period,   box to determine the days of the week when all Poll Periods 
will be active. 

To enter new Poll periods. 

 

Figure 4-11  Poll Period Dialog 

Click on existing Poll to edit existing periods. 

To edit. 

Enter the time Period Begins At. Calls will be made after this time.  

Note: if you do not define a Poll Period starting at 00:00, no calls will be made from 00:00 to the start 
time of the first Poll Period you define. If you wish to stop calls from a particular time: create a new 
Poll Period, specify the start time and place a check next to Stop Calls. No calls will then be until 
either: - 

The start of the following Poll Period that day (if there is one).  

Or the start of the first Poll Period, for the next scheduled poll day.  

To delete Poll Period click on existing Poll. 

4.3.1.5 Enter/Edit Daily Call Times. 

Daily Call Times are used to define specific times and days of the week to make calls. By default a 
new Call Schedule is set to make no calls at specific times. Daily Call Times may be created, and 
edited. 

To enter new call time.deleted using the appropriate buttons. 
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Figure 4-12  Call Time Dialog 

  box to determine the days of the week when Call Time will be active and set Time. 

To edit existing time. Select existing time. To enter Call Time 

To delete existing time. Select existing time. To delete 

4.3.2 Modem Set-up/Warnings. 
STACC Base Station can be operated with one or more modems. The number of modems required 
will depend on the total number of units being monitored and the quantity and number of calls made to 
each unit. If STACC is configured for Emergency calls it is recommended that a dedicated modem be 
used for incoming Emergency calls. STACC allows only one modem to be set for incoming Emergency 
calls and only one for incoming low priority calls. One modem can be set to receive both Emergency 
and low priority calls.  

4.3.2.1 Initialise Modems. 

STACC must have at least one modem enabled to communicate with the unit group. STACC will 
enable warnings if modems disabled. The modems are set-up from the Modem Status window that is 
enabled from the View menu. 
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Figure 4-13  Modem Status Dialog 

Click   to enable/disable selected Modem. 

To set up Modem Right click on selected Modem 

To enter COMx Port Properties. 

 

Figure 4-14  COM Port Properties Dialog 

Do not enter Modem Data Number unless Incoming calls permitted. For Emergency Call support 
Modem Data Number must be entered. 

If incoming calls permitted, enter Modem Data Number to enable Incoming Calls set up.  

The Base Station uploads to the unit, the incoming call Modem Data Number. Units have to be called 
at least once before they can initiate an incoming call. 

If Modem not activated when Port Properties enabled this warning is displayed. 
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4.3.2.2 Modem State Messages.  

 

"Initialising"  Base station modem is being set-up by STACC. 

"Awaiting for call request"  

“Awaiting Call 
Request/Incoming Call” 

“Awaiting Incoming Call” 

Modem is ready to make or receive a call, as soon as an 
incoming call received the call scheduler issues a call request or 
the user initiates a call-on-demand. 

"Finding Modem"  Modem has taken a call request and STACC is verifying that 
modem has a good connection with the base station PC. 

"Dialling xxxxx xxxxxx (<Unit 
Name>)"  

STACC is dialling a unit on the road and the remote unit has not 
answered the call yet. 

"Awaiting Data Connect"  Remote modem located by the GSM provider and STACC is 
waiting for GSM provider to establish a reliable connection. 

"Sending Synchro" GSM provider claims to have set up a dial-up connection 
between base and remote modems, STACC is now sending a 
synchronisation message which the remote unit will attempt to 
acknowledge. STACC will not initiate the download procedure 
until this acknowledgement is received. Synchronisation is 
required because the GSM network does not inform both parties 
of the CONNECT simultaneously. Synchronisation ensures both 
parties are ready before transfer of positional data takes place. 

"Sending UploadInit Message"  STACC base station software is satisfied that a good link has 
been established with the remote. The data transfer protocol is 
being initiated by the base station. 

 

"Sending State Count Msg" 

"Sending Upload Integer State 
Msg" 

"Sending Upload States 

STACC is transferring logging rate information to the remote 
unit. 
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Complete Msg" 

"Receiving State Count Msg" 

"Receiving DownloadHdr 
Message" 

Base station is receiving current UTC time (for keeping the PC’s 
internal clock accurate). 

"Receiving DownloadMsg" Base station is receiving positional data from the remote unit.  

"Sending Ack"  Base station is acknowledging the receipt of a packet of data 
from the remote. A packet is set up by default to be 100 
messages. 

"Sending EndDownload 
Message Ack"  

Base station is acknowledging that the latest positional data has 
been received. 

"Sending EndComm 
Message"  

Base station is informing the remote unit that communication 
has finished. 

"Terminating Data 
Connection"  

Base station is disconnecting the GSM data link with the remote 
unit. 

"Waiting for 'NO CARRIER'"  Base station is waiting for the GSM network to disconnect the 
phone call. 

"Hanging Up"  Base station modem is completing its call shutdown. 

"Terminating State Machine"  STACC is deactivating the base station modem 

"Modem Thread Shut Down"  Base station modem is deactivated. 

“Answering Incoming Call” Responding incoming call 

“Receiving Call Back Init” Receiving identity of and reason for incoming call. 

“Receiving Spot Location” Receiving spot location download. 

4.3.2.3 Modem Warnings. 

Warnings are displayed in the event of Modem failures or if the operator closes down a Modem used 
for Emergency Calls. 
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Figure 4-15  Modem Warning Dialog 

If you really wish to disable the Emergency Modem to clear warning 

 

 

Figure 4-16  Modem Emergency Warning 
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4.4 Preferences. 
The Preference window is used to set options for General operation, Unit, Communications, 
Database and Internet. 

Select Preferences from Tools menu.  
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4.4.1 General Preferences. 

 

Figure 4-17  General Preferences Dialog 

The General Preferences window is used to set: - 

History Sizes.  The number of entries that can be stored in the Call Request History, Call 
Notification History and Event Viewer (See 4.5.4., 4.5.5., 4.5.1.). Default setting 1000. 

Message Logging. Number of incoming data messages stored in message Cache before data saved 
to disc. Default setting 400. 

Timezone for Data Extraction. Select GMT (Universal Time) or Local Time Zone when extracting 
data. Map Screen and Tote Screen always use Local Time.  

Auto-Save Histories and Settings. Enable to save all Histories and Settings. 

Location Fix Extraction. Select the interval between fixes used when extracting locations from 
databases. If the interval at which location data is stored on the unit is greater, (See 4.3.1.) the unit 
rate will be used. 

Latitude and Longitude settings select units used to display position.  
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4.4.2 Unit Preferences. 

 

Figure 4-18  Unit Preferences Dialog 

The Unit Preferences window is used to set the unit symbol size and label details. The default value 
for Unit Symbol size is 30 points and the Label Type size 11 points.  
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4.4.3 Communication Preferences. 

 

Figure 4-19  Communications Preferences Dialog 

The Communication Preferences window is used to set parameters relating to both incoming and 
outgoing calls: - 

Packet Size. The number of messages downloaded from the unit in one block before error checking 
takes place. For efficiency the size of this should be matched with that of the Message Cache in the 
General Preferences. Default value 400. 

Comprehensive Fixes. If this is enable the location fixes will include, in addition to normal location 
data, information on the quality of the Satellite fix, For normal tracking the normal fix information is 
sufficient, Comprehensive Fixes may be required for detailed survey work. Enabling the 
Comprehensive Fixes will increase the download times and therefore the call costs. For a full 
download this will increase the call time by some 30%. 

ASCI Protocol. STACC normally communicates using binary data. Operating in ASCI will result in 
longer call times and therefore this function should not normally be enabled. This is primarily for 
service support. 

Use “9” Prefix for outgoing landline calls.  Enable if a landline connection, needing a “9” prefix is 
being used by STACC. 

Activate Diagnostics. Activates additional messages from the unit STU for service support. 
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Incoming Calls. If STACC is being used for incoming Emergency calls, it is advised that both Spot 
Location and Followed by Base-Initiated Call are enabled. This reduces the time that the incoming 
modem is unavailable for other Emergency calls. Remote Unit retries can be set to a maximum of 20.     

Driver Messaging. If the STACC messaging system is being used this section controls the SMS and 
Data communications. In addition it enables the logging of non STACC SMS Text messages.  

Selecting STACC front on incoming will automatically bring STACC to the front of the display on 
receipt of a new message if the computer is being used to run other programmes at the time. 
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4.4.4 Database Preferences. 

 

Figure 4-20  Database Preferences 

The Database Preferences is used to change the location of the STACC database. To change 
database it is necessary to disable any active modem. A warning will be displayed if STACC modem 
still active 

 

The following warning is displayed when changing database locations: - 
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Figure 4-21  Database Location Warning Dialog 

4.4.5 Auto Extraction Preferences. 

 

Figure 4-22  Auto Extraction Preferences Dialog 

The Auto-extraction Preferences are used where data is required to be automatically extracted to a 
file.  
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4.4.6 Reports Preferences. 

 

Figure 4-23  Report Preferences Dialog 

The Report Preference is used to select settings used in the production of reports and to select the 
report options displayed when running STACC. 

Unit Reports set the times used by the reports that display Standing and Idling times. 

Report Addresses enable Latitude and Longitude to be translated to an address when used in the 
reports.  Addresses can be replaced by user entered Place Labels if required. 

If only a few reports are used then the Report Selections can be used to reduce the choice of reports 
when producing reports in STACC.  
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4.4.7 Internet Preferences. 

 

Figure 4-24  Internet Prefences Dialog 

The Internet Preferences window is used to enable FTP transfers. 
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4.4.8 Measurement Preferences. 

 

Figure 4-25  Measurement Preferences Dialog 

The Measurement Preferences window is used to select the units used in reports and on the Map 
Screen. . 
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4.5 Status reports/history. 
Various reports are provided for the management and support of the STACC System. Two of these, 
the Event Viewer and the Call Request Queue are sometimes used during day to day operations.  

4.5.1 Event Viewer. 
The Event Viewer records all significant events of STACC’s operation. 

 

Figure 4-26  Event Viewer Dialog 

 

More information of each event can be obtained by Right click on selected event for More Info. 
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Figure 4-27  Typical More Information Dialog 

Event Viewer records include: - 

 

Event Description Further information 

Starting STACC Program. Time STACC app started   

Shutting down STACC Time STACC app closed  

Improper Shutdown STACC previously shut down 
unexpectedly. 

Possible causes:- 

Power cut at STACC Base Station 
PC. 

Forced Quit – user terminated the 
STACC process. 

A General Exception fault 
occurred. 

Out Of Contact Unit unobtainable after 
maximum call retries 

 

Emergency: The panic alarm was triggered Time the event was raised. 
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Time base station received 
notification. 

Time the event was acknowledged. 

Emergency Modem 
Inactive 

The one and only modem for 
emergency calls is 
deactivated.� 

Time Event 
occurred/acknowledged Possible 
causes:- 

Base modem is ticked in modem 
status dialog. 

Base modem power light is on. 

The serial cable is connected 
between the PC and the base 
modem. 

 

Base Modem Not 
Responding 

Modem isn't responding to AT 
commands 

As above. 

All Outgoing Modems 
Inactive 

Last base modem for outgoing 
calls is deactivated. 

As above. 

Incoming Modem Inactive The one and only modem for 
incoming calls is deactivated. 

As above. 

 

4.5.2 Call Request Queue. 
The Call Request Queue displays the current status of outstanding calls. 

 

Figure 4-28  Call Request Queue Dialog 

To remove a call from the Call Request Queue: - 
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Right click on call to be removed 

To remove call.  

Note: Cancelling of scheduled calls may result in the loss of data. Data loss will occur if the unit is 
not called again before the unit’s STACC STU overwrites previously stored data. 

4.5.3 Call Notification Queue. 

 

Figure 4-29  Call Notiification Queue Dialog 

Finished calls are held in the Call Notification Queue. Periodically (approximately every 5 seconds) 
the Call Scheduler process these calls, rescheduling the incomplete ones and updating the Call 
Notification History.  See 3.2.1.2. for description of Completion State. 

4.5.4 Call Request History. 
The Call Request History is a record of all requests for outgoing calls made by the Scheduler, 
including retries.  
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Figure 4-30  Call Request History Dialog 

4.5.5 Call Notification History. 
The Call Notification History is a record of all completed calls. Completed calls are those which 
successfully download all available data from the unit or do not establish contact after specified 
number of retries. See 3.2.1.2. for description of the Completion State messages   

 

Figure 4-31  Call Notification History Dialog 
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5 REPORTS AND DATA EXTRACTION 

5.1 Reports and Databases 
Data gathered by STACC can be processed to produce a range of reports and databases. There are a 
range of standard reports and databases. In addition custom versions are available. This manual 
covers the principal operation of the report system and gives some examples of the outputs. Please 
contact Service for support of other report types. 

STACC has a User Interface for generating reports which is referred to as the Report Centre. 

5.2 To Enter the Report Centre. 
The Report Centre can now be entered directly from the main menu bar. 

Left click on to enter Report Centre 

The Report Centre can also be opened from the Tote Screen by right clicking on a Fleet or 
individual Unit and selecting Reports from the displayed context menu. From the Map Screen right 
click on a selected vehicle to display context menu and select Reports. 

5.3 Report Centre. 
The  Report Centre is used to produce all STACC reports. From this window the type, period and shift 
time of the report can be set. For unit based reports an individual unit or, where appropriate, group of 
vehicles, can be selected. Reports can also be produced based on specified geofences or Driver PIN. 
See 5. for details of PIN reports. 

The reports listed in the Report Type box can be selected from the Report Preferences.  See User 
Guide section 4.4.6 
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5.3.1 Unit Reports 
To produce a unit report:- 

 

Figure 5-1  Report Centre Dialog For Units 

Left click on required report type.  

Select Unit (or for Group and Position reports multiple Units) by ticking or unticking box in Select 
Unit. 

Set Analyses Period and if required Shift Time, then press Create Report 

To create Report  
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5.3.2 Geofence Reports 
To produce an Area Geofence report:- 

 

Figure 5-2  Report Centre Dialog For Geofences 

Left click on required report type Area Geofence.  

Select Geofence(s) by ticking or unticking box in Geofence Specific Data box. Select either 
Geofences by STU Msg, for actual Geofences reported by the STU, or Geofences by Position, if no 
Geofence messages have been received for the location and period. 

Set Analyses Period, then press Create Report 
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5.3.3 Example Reports 

5.3.3.1 Location Report 

 

Figure 5-3  Location Report 

This report records details of all unit movements and idling times. The location of the unit is shown 
when it is stationary. The unit is considered to be stationary when the ignition is turned off or no 
movement is detected by a preset time. This time is set in the Report Preferences (see 4.4.6) 

If the fuel flow data is available to the STACC STU, the fuel mpg will be shown for individual trips and 
for the total period of the report.  
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5.3.3.2 Real Time Events. 

 

Figure 5-4  Real-Time Event Report 

The Real Time report displays the time and location at which an event took place. An event can be for 
example, as above, cruise control engage, disengage. STACC can be configured to give a number of 
different event reports depending on individual requirements.   
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5.3.3.3 Performance Reports 

If J1939 CAN data is available on the unit it is possible to produce a series of reports covering driver 
performance. The actual reports that can be produced will depend on the actual CAN messages 
available. Typically we can produce reports on gear use, revband usage, harsh breaking, clutch pedal 
usage etc. The report below is a typical example. 

 

Figure 5-5  Gear Report 

5.3.3.4 Idling Report for Vehicles with PTO 

The simple Idling report records all the times that the vehicle is stationary with the engine running for a 
period greater than a time set in the Report Preferences. See 4.4.6.  
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If a vehicle is fitted with PTO, then if the PTO is engaged during the time defined above, the actual 
idling time should not include the time when the PTO is active. 

The idling report now gives the option to produce reports which take account of the PTO time during 
idling time. The report supports all existing vehicles that are detecting PTO using CAN. 

Vehicles that are using non Can detection may need an upgrade in the STU firmware to use this 
function. Contact your STACC Technical support if you require assistance with this. 

This report only deals with PTO during idling periods. If you require PTO reports including PTO during 
vehicle movement, this can be seen in the Real Time Events report.  

When selecting Idling Report the following options will be displayed: - 

 

Put √ in the � to enable Use of PTO Data. 

Remove √ from � to disable Use of PTO Data. 

Show Non PTO Data will show only the time when the vehicle is stationary with the engine running 
and the PTO not engaged. 

Show PTO Only will show the time that the PTO was engaged whilst the vehicle was stationary. 

Show Both PTO and Non PTO will show the total time the engine was running with the vehicle 
stationary, the time when the PTO was engaged and the time when the PTO was disengaged. 
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Figure 5-6  Idling Report 

5.3.4 Viewing/Printing/Exporting Reports 
Use the tool bar controls to page through multi-page reports and change the report view. 

 

Figure 5-7  Report Dialog Toolbar 

  To print report 

To export report 
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Figure 5-8  Report Export Dialog 

Select Export format and file destination. 

 To toggle Group Tree giving easier acess to multii page reports 

 

Figure 5-9  Report Group Tree 
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6 DRIVER PINS. 

6.1 Introduction. 
Reports based on Driver Personal Identification numbers (PIN) can be produced. In order for 
STACC to support this function mobile units must be fitted with an In Cab Display and the PIN 
enabled firmware installed. Units installed before August 2003 will almost certainly need the 
firmware to be updated. Contact Technical Support for further details. 

6.2 Set up for Driver PIN. 
From Menu select Group then select Drivers. This will open a text file in which the Driver PIN and 
name can be entered using the format below.. 

 

Figure 6-1  Notepad Showing Drivers File 

Note:  If you do not wish to show the Driver names on the report simply list the PINs.   
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6.3 Creating Driver Reports. 
The Drivers should enter their PIN at the start of work and Log Off at the end of their shift. The reports 
will not use any data collected outside any logged on work period.  

There are two Driver based reports which can be produced the first includes details of all logged 
periods for the analyses period. The second shows a summary for all logged on periods during the 
analyses period. Single reports can be produced to include a number of Drivers 

To produce a Driver PIN report:- 

 

Figure 6-2  Report Centre For Drivers 

Right click on required report type Driver Details or Driver Summary.  

Select Drivers by ticking or unticking box in Driver Report Specific Data box. 

Set Analyses Period. 

To create Report  
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6.4 Driver Details Report. 

 

Figure 6-3  Example Driver Details Report 

6.5 Driver Summary Report. 

 

Figure 6-4  Example Driver Summary Report 
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7 APPENDIX. 

7.1 Call intervals and rates. 
When setting unit Logging rates and Intervals between calls to units there are a number of areas to be 
considered.  

The shorter the logging rate, the more often the unit will have to be called to avoid overwriting stored 
data that has not been downloaded to the Base Station. Fig (6.1) and Fig (6.2) show the safety 
margins, the time left, in which to recall the unit before data will be overwritten for various call intervals 
and logging rates.  
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Figure 7-1  Call Intervals Graph 

Call Safety Margin for Unit Logging rates 10 to 60 Seconds. 

There is no limit to the number of units that STACC can monitor, however there is a limit to the rate 
that calls that can be made from a single modem. STACC can use more than one modem for outgoing 
calls if required by the system. The unit logging rate and the call interval also affect the number of calls 
that can be made in any period. See Fig (6.3) and Fig (6.4). However, although shorter calling 
intervals for any given logging rate allow more calls to be made in any given time, longer call intervals 
are more cost effective. 
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Figure 7-2  Safety Margin Graph 

If STACC is used mainly to acquire data for later analysis then it makes economic sense to select a 
calling interval and logging rate to give the longest calling interval acceptable. If it is necessary to have 
the base Station updated with the unit's position at fairly short intervals, then longer logging intervals 
will keep the call costs lower.  
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Figure 7-3  Maximum Calls Per Hour Graph 
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Figure 7-4  Maximum Calls Per Hour For Unit Logging Rate 1 to 10 mins 

Peak Call Costs at 8p per Minute for Vehicle Logging Rates 1 to 5 Minutes 
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Figure 7-5  Costs Graph 
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